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•

Mosart Web Applications are value-adding utilities and plugins that simplify working with Viz 
Mosart.
Mosart Web Applications are not part of a standard Viz Mosart delivery.

The following Mosart Web Applications are available:

Mosart NRCS Plugin
Mosart Timing Display
Mosart Rundown Viewer
Mosart Dashboard
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•

1 Download
Collect the latest software bundle from Vizrt's customer FTP at https://download.vizrt.com/
by navigating to /products/VizMosart/Latest Version/WebApplications/.

Note: If upgrading, make sure an existing instance of the Mosart Web Applications 
Configuration Tool is not open.



https://download.vizrt.com/
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1.

2.

3.

2 Installation
The Mosart Web Applications bundle shall be installed on the Viz Mosart server.

Run the downloaded file MosartWebApplications.Bundle-n.n.n.n.exe.

The web applications that will be installed are listed.

Click Install.
Any previously installed versions of the Mosart Web Applications are automatically 
upgraded. 
After successful installation, a Mosart Web Applications Configuration Tool automatically 
displays.

a.
b.

Note: The Installer places two applications on the local machine
Vizrt Mosart Web Applications
Vizrt Mosart Web Applications Configuration Tool


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4.

a.

b.

5.

•
•
•
•

Port settings (optional)
Where security policies restrict ports firewall ports, these are the necessary port numbers for 
Mosart Web Applications:

Web Apps REST API
http: 55142.
https: 55143.
Remote Control Service (Used by the Timing Display and Rundown Viewer)
http: 55167.
https: 55168.

Follow the Configuration section to continue setup.

Mosart NRCS Plugin
Mosart Timing Display
Mosart Rundown Viewer
Mosart Dashboard

Note: A desktop shortcut to Mosart Web Applications Configuration Tool is added by 
default.


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3 Related Documents
Viz Mosart User Guide: Contains information on how to use Viz Mosart in live production.

For more information about all of the Vizrt products, visit:

www.vizrt.com
Vizrt Documentation Center
Vizrt Training Center
Vizrt Forum

http://www.vizrt.com/
http://documentation.vizrt.com/
http://www.vizrt.com/training/
http://forum.vizrt.com/
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4 Feedback And Suggestions
We encourage suggestions and feedback about our products and documentation. To give feedback 
and/or suggestions, please contact your local Vizrt customer support team at www.vizrt.com.

http://www.vizrt.com/
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5 Mosart NRCS Plugin
The NRCS Plugin is an effective drag and drop tool for reliably adding Viz Mosart template 
instructions to an NRCS story.

Working with the NRCS Plugin
Setup and Administration
Integrating with an NRCS

5.1 Working With The NRCS Plugin
The NRCS Plugin delivers the functionality previously provided by the legacy Viz Mosart 
ActiveX Plugin.

User Operations
Getting Help
Error Handling
API Documentation

Note: For news-breaking details on the Mosart NRCS Plugin, please refer to the Mosart Web 
Apps Release Notes for your version of Viz Mosart at the Vizrt Documentation Center. 



Tip: This document contains animated graphics. If you are viewing as PDF, we recommend 
browsing the web version.



http://docs.vizrt.com/viz-mosart.html
http://docs.vizrt.com/viz-mosart-webapps/1.6/Mosart_NRCS_Plugin.html
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5.1.1 User Operations
Searching for a Template
Modifying a Template
Adding Template Details to the NRCS
Template Change Alert
Optimizing Your NRCS Plugin Workspace
Copying the MOS Object Details
Modifying Existing MOS Objects

Searching for a Template
Locate a template by typing a variant or template type in the Search box. Auto-suggest starts 
displaying search results as you type.
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Text highlighting helps with pinpointing search results:

Modifying a Template

To modify production characteristics
Variables

Click on a template in the search listing. Properties (called Variables) that have been added 
to the template (using Viz Mosart's Template Editor) appear to the right.

You can temporarily override any defaults, and add new variables.
For example, in a Video Effects template, you may wish to change the source of the second 
input:

Transitions

Note: Variables are called Newsroom tags in the Viz Mosart Template Editor.
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The Transition field initially displays the default transition type. This value indicates the 
most significant template behavior.
You can temporarily modify this transition type, and then later restore the default transition 
(as originally set in the Template Editor).

Adding Template Details to the NRCS
Drag and drop the template into the required location of the story slug.

Template Change Alert
If simultaneous changes are being made to the active template set (by another operator 
using Viz Mosart's Template Editor), the Refresh button flashes orange. 

You can restore the default transition by clicking the Reset button.

Note: The names of both the gallery and the template set of your selected template 
are always included with the MOS object that you store as a story item in your NRCS 
rundown. 
           Any future use of this NRCS MOS item will always point to exactly the same 
template (same gallery, template set and template name) when it displays in the 
Mosart NRCS Plugin.


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•

To fetch the latest changes, click the Refresh button.

Optimizing Your NRCS Plugin Workspace

Collapsing the Type listing
You can save some screen space taken by the Mosart NRCS Plugin by collapsing the Template 
Types panel: 

Click the Collapse button.

Scaling the View
As the Plugin is a web application, you can set your preferred scale by zooming in and out.

For most browsers, you can use the shortcut Ctrl+mouse wheel.
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1.

2.

Copying the MOS Object Details
You can work with the template's raw MOS data by first copying it to your PC's clipboard.

From a selected template, click Copy MOS.

Modifying Existing MOS Objects
Your rundown will usually contain slugs with MOS objects that have been created with either this 
Mosart NRCS Plugin or the legacy component, Viz Mosart ActiveX.

To modify an existing MOS object
On the selected rundown story, double-click the slug or grommet that holds the story's MOS 
object.
The corresponding Viz Mosart template, complete with any control details like 
newsroomtags, crosspoints, transition, timings, is displayed in the Viz Mosart NRCS Plugin.
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3.
You make modifications direct in the Mosart NRCS Plugin window.
The name of the template you are working and reference to which template set it is part of, 
is displayed on the border of the Plugin menu.

When finished editing click Apply, then OK.

Note: You cannot modify a MOS object that refers to a not-found Viz Mosart 
template.


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•

To modify MOS objects created with the Mosart NRCS Plugin
MOS objects created by the Mosart NRCS Plugin include references to the gallery name and 
template set name.

If your rundown item refer to a template set that cannot be found in the gallery, the Mosart 
NRCS Plugin checks the active gallery  and template set for a corresponding template. This 
valid reference is then applied to the MOS object, when you click Apply on the replacement 
template.

Alternatively, you can manually search gallery/template sets to locate a similar template.
After editing and clicking Apply, the new (active) gallery and template set name are stored in 

Note: The active Gallery and/or Template set name may automatically change if your 
selected MOS object references a different gallery/template set. You are always 
notified if this happens.


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•

your rundown MOS object.

To edit MOS objects created by ActiveX
When working with MOS objects that were created with Viz Mosart's legacy NRCS Plugin (Mosart 
Active-X) the currently selected gallery name and template set name will always be used as 
template source.

In the Plugin, ensure to select correct gallery and template set before you start editing.

5.1.2 Getting Help
The NRCS Plugin documentation is continually updated and available online. This includes both 
this User Guide and the Release Notes.
You can also send your feedback directly to the Mosart NRCS Plugin design team.

Click the Question mark icon at the top right:

5.1.3 Error Handling
While navigating through templates, if there are exceptional conditions, the Mosart NRCS Plugin 
displays an error message. 
See the example below:
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Please contact Vizrt Support if you encounter any error messages.

5.1.4 API Documentation
The NRCS Plugin also installs the Mosart REST API. Details about the API endpoints are provided in 
the open API documentation (Swagger Open API (OAS) documentation) at:
http://localhost:55142/docs

Examples
Retrieve all galleries:
http://localhost:55142/api/v1/galleries
(A list of gallery names is obtained)
Choose a gallery name from the list obtained in the previous example. For the sake of this 
example, assume that Local was on the list. (If not, choose some other gallery name.)
To retrieve the template sets for the gallery named Local:
http://localhost:55142/api/v1/galleries/Local/templatesets.

5.2 Setup And Administration
This section describes setup and post-installation configurations, usually performed by a system 
administrator.

Setting up the NRCS Plugin
Download
Installation
Configuration
Additional Server Settings
Verifying the Installation

Troubleshooting
Web Apps Service reports as offline
Bypass the Mosart Web Applications Configuration Tool to access Web Apps
Firewall Ports

Before the NRCS operators can work with Viz Mosart templates using the Plugin, the system 
administrator must complete a one-time setup.

Note: Replace localhost with the IP address of the computer on which the API is installed.

http://localhost:55142/docs
http://localhost:55142/api/v1/galleries
http://localhost:55142/api/v1/galleries/Local/templatesets
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1.

2.

5.2.1 Setting up the NRCS Plugin
Perform all three procedures, Download, Installation and Configuration.

Download
Collect the latest software bundle from Vizrt's customer FTP at https://download.vizrt.com/
by navigating to /products/VizMosart/Latest Version/WebApplications/.

Installation
The Mosart Web Applications bundle shall be installed on the Viz Mosart server.

Run the downloaded file MosartWebApplications.Bundle-n.n.n.n.exe.

The web applications that will be installed are listed.

Click Install.
Any previously installed versions of the Mosart Web Applications are automatically 
upgraded. 

Note: If upgrading, make sure an existing instance of the Mosart Web Applications 
Configuration Tool is not open.



a.
b.

Note: The Installer places two applications on the local machine
Vizrt Mosart Web Applications
Vizrt Mosart Web Applications Configuration Tool



https://download.vizrt.com/
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3.

4.

a.

b.

5.

After successful installation, a Mosart Web Applications Configuration Tool automatically 
displays.

Port settings (optional)
Where security policies restrict ports firewall ports, these are the necessary port numbers for 
Mosart Web Applications:

Web Apps REST API
http: 55142.
https: 55143.
Remote Control Service (Used by the Timing Display and Rundown Viewer)
http: 55167.
https: 55168.

Follow the Configuration section to continue setup.

Note: A desktop shortcut to Mosart Web Applications Configuration Tool is added by 
default.


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1.

Configuration

If the warning CONFIGURATION REQUIRED appears in the NRCS Plugin panel, click Configure.
Follow the guidelines below:

Step Description

(1) Template location Select whether your Viz Mosart templates are defined 
in a local file or on a separate database.
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•

Step Description

(2) Template access Local: Usually C:\channeltemplates\

A check is made for existence at the stated 
destination, for all three files:

channeltemplates.xml
avconfig.xml
newsroomsettings.xml
If  all are found, a confirmation text Valid 
folder is displayed. 
Click Next.

Database: URL (Host + DB name) and DB access 
credentials
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•

a.

b.

c.

Step Description

(3) NRCS type Select the NRCS system you are using.
Supported systems are ENPS, iNEWS, Octopus.

Any NRCS that can handle html plugins should work 
(select Other), but the above 3 are supported.

mos id
Mandatory field if you select NRCS type ENPS, 
Octopus or Other.
(not used in iNews). 

To find yourMos ID

In the Manus Administrator console, type 
SETTINGS.
From the configuration panel that opens, 
look for MosId.
The value is defined in the column to the 
right (in this example mosart.mos)

For more details, see the Viz Mosart Administrator 
Guide, section Manus Administrator > Settings Editor 
MOS > NRCS Configuration.

http://docs.vizrt.com/viz-mosart.html
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2.

3.

1.

2.

Setup is complete and a confirmation menu summarizes your details.

Click Finish.

Additional Server Settings

Web server hostname
At startup, the Configuration Tool attempts to autodetect the web server hostname and if 
successful, pre-populates the field.

For some setups, the Configuration Tool's web server pre-populated hostname will differ from the 
fully qualified domain name (FQDN). For example, the hostname gets automatically pre-populated 
as web-apps, yet the FQDN is web-apps.example.com.

To enable network communication with Mosart Web Apps
You can enable other machines on the network to reach Mosart Web Apps.

From the Configuration Tool menu bar, click the Settings (gear) icon.
The Server Configuration menu appears.

In Web server hostname, enter the FQDN.
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3.

1.

2.

3.

4.

5.

1.

2.

•
•
•

Click Save.

Enabling HTTPS
The Web Applications suite optionally supports HTTPS authentication for the applications running 
under it, with a centralized interface to help with certificate configuration.

Step 1 - Activate HTTPS in Mosart Web Applications
Launch the Viz Mosart Web Applications Configuration Tool (a desktop shortcut is usually 
available by default).
In the top right corner, select the Settings (gear) icon.
The Server Configuration menu appears.
Select Use HTTPS.

Provide certificate, key and authentication details (consult with your IT department to obtain 
this).

Click Save. 

Step 2 - Turn HTTPS on in Mosart Remote Dispatcher Service
Copy the file "C:\Program Files (x86)\Mosart Medialab\Mosart 
Server\ConfigurationFiles\RemoteDispatcherServiceConfig.xml" to "C:\ProgramData\Mosart 
Medialab\ConfigurationFiles".
Fill in the following fields, using the same three values from the HTTPS Configuration menu 
shown above:

SignalRUseHttps: true
SignalRCertificatePath: <Certificate File entered above>
SignalRCertificateKeyPath: <Private Key entered above>

Note: Depending on the application, some additional configuration may be needed in the 
connected applications (for example Viz Mosart itself) to enable HTTPS communication.



Note: This selection turns on HTTPS for the NRCS Plugin, Mosart Timing Display and 
Rundown Viewer.


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•

3.

1.

2.
a.

b.

3.

SignalRCertificatePassword: <Password entered above>

Restart the Remote Control Service.

Verifying the Installation
After entering NRCS type above, clicking Next starts a background Windows service, Mosart 
REST API (a combination of the REST API and the NRCS Plugin).
You can check that the NRCS Plugin is accessible by either:

In the Configuration Tool, clicking Open.

or
following the URL next to the Copy button.

To complete the integration, configure the NRCS side, according to the appropriate NRCS as 
described in section Integrating with an NRCS, where you will use the copied URL. 

5.2.2 Troubleshooting

Web Apps Service reports as offline
At any time you can start the Mosart Web Applications Configuration Tool and check operating 
status.

The Plugin URL comprises the machine name, port number 55142, NRCS type 
and (when supported) mos id in the form: http://machine-name:55142/plugin
?nrcs={type}&mosid={mosid}


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1.

2.

•

•

•

A common error is when a Windows service has failed.

Try restarting the service with the Restart button.

You can also rewrite any previously entered values with the Reconfigure button.

Bypass the Mosart Web Applications Configuration Tool to access Web Apps
In failure situations, you can use your web browser to communicate with the Mosart Web Apps 
(instead of the Configuration Tool).

NRCS Plugin
From the Configuration Tool, copy the NRCS link (click Copy).

The URL has the form similar to: http://<your-hostname>:55142/plugin/?
nrcs=ENPS&mosid=mosart
Open you web browser and paste the URL in to see the NRCS Plugin.

Rundown Viewer
Edit the URL to: http://<your-hostname>:55142/rundown

Timing Display:
Edit the URL to: http://<your-hostname>:55142/timingdisplay/editor

Firewall Ports
Refer to the optional Configuration step Port settings (optional). 
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1.

2.
3.

5.3 Integrating With An NRCS
This section describes

NRCS Integration
ENPS
iNEWS
Octopus

The server-based plugin configuration described below avoids having to configure each 
individual NRCS client.
This section assumes the Mosart NRCS Plugin has been successfully installed and set up, as 
described in section Setup and Administration.

5.3.1 NRCS Integration
The NRCS Plugin supports connections to

ENPS
iNEWS
Octopus.

You connect each client NRCS machine to the Viz Mosart server (which hosts the Mosart REST API.)

ENPS
In the Configuration Tool (if not already running, select Windows Start > Viz Mosart NRCS 
Plugin Configuration Tool) on the Mosart server, collect the NRCS Plugin's URL with the Copy
button:

On the ENPS machine, navigate to System Maintenance > MOS Configuration.
Paste the NRCS Plugin's copied URL, similar to the example below:

Note: Initial investigations show that the NRCS Plugin also works with OpenMedia. However 
this connection is currently not officially supported by Vizrt.


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1.

2.

•

3.
•

•

•
i.
ii.

iii.

iNEWS
There are two possible setup routes, depending on whether your iNEWS version supports HTML5 
plugins. Please consult the documentation of your iNEWS system to determine whether this is the 
case.

iNEWS Clients with HTML5 Support
iNEWS Clients without HTML5 Support

iNEWS Clients with HTML5 Support
In the iNEWS client, from the directory navigation tree, open the file SYSTEM.MOS-MAP and 

verify that between TABLE-START DeviceTable  and TABLE-END  there is a line

mosart ...
If not, add the mosart reference,

For example: mosart MosartNRCSPlugin
For this step and the next, please refer to Avid's MediaCentral Newsroom Management Setup 
and Configuration Guide, section Configuring Newsroom Management for HTML5 (chapter 
HTML5 Plugins) .
If you have at least one HTML5 plugin already defined, you can skip this step. 
From Avid's Configuring Newsroom Management for HTML5, follow the 1 to 6 with one 
clarification:

Step 3: (name of the new queue): Use the name HTML-PLUGINS, as recommended by 
Avid.

Continue with steps 7 to 10, observing these clarifications:
Step 7: In case you skipped the previous step, the queue refers to SYSTEM.HTML-
PLUGINS
Step 9: (slug): Enter something like Viz Mosart NRCS Plugin. (This is the string that will 
be shown in the Plugins sub-menu of the Tools menu.)
Step 10: (parameters): In the Story panel,

Enter 'URL = '.
At that exact spot, paste the URL copied from the Configuration tool
(if the Configuration Tool is not already running, select Windows Start > Viz 
Mosart NRCS Plugin Configuration Tool)

.
Finally, append

•

Note: The URL comprises a combination of the Plugin's URL + a fixed port number 
and Viz Mosart's MosId value in the form:
           http://machine-name:55142/plugin?nrcs=ENPS&mosid=xxxx.

If you need to derive current MosId value, see the item To find your Mos ID.



https://resources.avid.com/SupportFiles/attach/MediaCentral_Newsroom/MCNM-SCG-2021.11.pdf
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1.

2.

mosItemBrowserProgID = Mosart.ActiveX
mosItemEditorProgID = Mosart.ActiveX

For example:

URL = http://BGO-EDR2:55142/plugin?nrcs=iNews

mosItemBrowserProgID = Mosart.ActiveX
mosItemEditorProgID = Mosart.ActiveX

iNEWS Clients without HTML5 Support
Installing the iNEWS Client Addon

For older versions of iNews without HTML5 support, you need to install a small wrapper utility, 
the Mosart NRCS Plugin - iNEWS Client Addon on each iNEWS client machine.

From the Vizrt FTP /products/VizMosart/Latest Version/WebApplications/
download and run the utility file MosartNRCSPlugin-iNEWSClientAddon-1.1.0.94.exe
Under Install options > Mosart NCS Plugin URL, paste the URL of the Plugin (http://machine-
name:55142/plugin?nrcs=iNews).

•

•

Note:
The parameter mosItemPlayerProgID mentioned in the Avid document is not
mandatory in this context.
The URL element mosid is not required for iNEWS.



Note: If Mosart ActiveX opens when trying to modify/edit a Mosart items (when double 
clicking on the item), you must first uninstall Mosart ActiveX.



Note: This is the URL you save with the Configuration Tool Copy button.
If the Configuration Tool is not already running, first select Windows Start > Vizrt 
Mosart Web Applications Configuration Tool.

.


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3.
4.

1.

2.

Click Install.
Open/Restart your iNEWS Client.
The Viz Mosart NRCS Plugin is under:
Tools > Plugin > Mosart NRCS Plugin.

Octopus
In the Configuration Tool, (if not already running, select Windows Start > Vizrt Mosart Web 
Applications Configuration Tool) on the Mosart server, collect the NRCS Plugin's URL with the 
Copy button:

Log-in to Octopus with Admin privileges.

Note: If Mosart ActiveX opens when modifying a Mosart items (by double clicking on it), 
uninstall, then reinstall the file MosartNRCSPlugin-iNEWSClientAddon-1.1.0.0.exe.


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3.

4.

5.
a.
b.
c.

From the sidebar, navigate to MOS Devices > Devices, select mosart and click Edit.

Select the Plugins tab:

Fill-in as below, and providing:
A unique name
Version
The URL to the Viz Mosart NRCS Plugin (pasted from step (1).
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6. Setup is complete. 
When editing a selected rundown, the user right-clicks for New > Create using <given name 
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of the Plugin>

For more details, see the Viz Mosart Administrator Guide, section Manus Administrator > Settings 
Editor MOS > NRCS Configuration.

http://docs.vizrt.com/viz-mosart.html
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•

•

•

•
•

•

6 Mosart Timing Display
The Mosart Timing Display web app provides browser-based timing information for the studio 
control room and studio floor.

Synchronizes with the active Viz Mosart rundown, it can be customized to display user-
specific details.
Supports a variety of devices.
For example an iPad or networked phone.
Provides multiple, customized timing displays.
For example, one timing display can be running on the studio floor, connected to the in 
house intercom system. A second timing display is in the control room counting down 
packages, keeping the producer updated on the current show.

This section describes:

Working with the Timing Display
Setup and Administration

6.1 Working With The Timing Display
Key Features

Currently the Timing Display web app's counters are hard coded to 25 Hz video frame rate. 
This means the counters will not be correct for other video frame rates, like 29.97 Hz.



Note: For news-breaking details on the Mosart Timing Display, please refer to the Mosart 
Web Apps Release Notes for your version of Viz Mosart at the Vizrt Documentation Center. 



http://docs.vizrt.com/viz-mosart.html
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•
•
•

•

•
•
•

•
•

Operating Modes
View Mode
Edit Mode

Distributing a Timing Display

6.1.1 Key Features
Supports a variety of devices (for example an iPad or networked phone).
A 24 x 24 editing grid enables rich flexibility for timer layouts.
Each timer has a consistent and readable appearance. Available space is optimized with 
proportionate fonts.
Rapid drag and drop of timer elements, from an intuitive list.
Rich text formatting: Color picker + Bold + Alignment + Show label.

6.1.2 Operating Modes
For daily operations, the Timing Display runs in View Mode. Use Edit Mode to create or adjust the 
display.

View Mode
Browse-anywhere timing information in your web browser.

In View mode you can:
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•

•

•

•
•

1.
a.

b.

2.
a.

Mouse-over a timing detail for an explanation.

Display as full screen.

Select any other defined view of the display.

To display a Timing Display in View Mode
View Mode is the result of Distributing a Timing Display.
You can also browse a Timing Display in View Mode, by clicking the View button in the menu 
bar.

The View Mode opens in a new tab.

Edit Mode

To Create and modify a Timing Display
You can reconfigure or create a new Timing Display with details relevant to your operation.

If no Timing Display editor is running in your web browser
From the desktop shortcut or Programs menu, start the Viz Mosart Web Applications 
Configuration Tool.
In the Timing Display panel, click Open.
A Timing Display editing web page opens.

Configure the display. For example:
From the Timers panel to the left, drag any highlighted timing detail into the display 
area.
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b.

3.

1.

2.

3.

From the display area, click on any timing detail and edit/delete.

 

From the menu bar, click Save as and enter a unique, meaningful name for the display.

6.1.3 Distributing a Timing Display
Once you have created or modified a Timing Display, you can share it with other users on the same 
network.

To Distribute a Timing Display
Create/modify the Timing Display as described in Creating and modifying a Timing 
Display above.
From the drop-down menu, select the required display.

From the menu bar top-right, select Copy link.

Note: The action Delete simply returns the selected timing detail back to the 
Timers selection panel on the left.


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4.

•
•
•
•
•

•
•

•
•
•

•

Share the URL with your users.

6.2 Setup And Administration
Setting up the Timing Display

Prerequisites
Download
Installation
Configuration

Support for main/backup Connection
Troubleshooting

Web Apps Service reports as offline
Bypass the Mosart Web Applications Configuration Tool to access Web Apps
Firewall Ports

6.2.1 Setting up the Timing Display

Prerequisites
Viz Mosart 5.0.3 or later.

Note: The original Viz Mosart Timing Display, with explanation of the elements, is 
described in the Timing Display section of the Viz Mosart User Guide.



1.
2.
3.
4.

Tip:
Appearance of timing information in the Viz Mosart UI

Counts the downtime to the next break.
Counts how much the rundown is over/under.
Counts down the remaining time for the current On Air template.
Shows the duration of the current On Air template.



Note: Timing Display will work out of the box, as long as you install the Mosart Web 
Applications on the same machine as the Viz Mosart Server.



https://docs.vizrt.com/viz-mosart-users-guide/5.1/Timing_Display.html
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•

1.

2.

Perform all three procedures, Download, Installation and Configuration.

Download
Collect the latest software bundle from Vizrt's customer FTP at https://download.vizrt.com/
by navigating to /products/VizMosart/Latest Version/WebApplications/.

Installation
The Mosart Web Applications bundle shall be installed on the Viz Mosart server.

Run the downloaded file MosartWebApplications.Bundle-n.n.n.n.exe.

The web applications that will be installed are listed.

Click Install.
Any previously installed versions of the Mosart Web Applications are automatically 
upgraded. 

Note: If upgrading, make sure an existing instance of the Mosart Web Applications 
Configuration Tool is not open.



a.
b.

Note: The Installer places two applications on the local machine
Vizrt Mosart Web Applications
Vizrt Mosart Web Applications Configuration Tool



https://download.vizrt.com/
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3.

4.

a.

b.

5.

After successful installation, a Mosart Web Applications Configuration Tool automatically 
displays.

Port settings (optional)
Where security policies restrict ports firewall ports, these are the necessary port numbers for 
Mosart Web Applications:

Web Apps REST API
http: 55142.
https: 55143.
Remote Control Service (Used by the Timing Display and Rundown Viewer)
http: 55167.
https: 55168.

Follow the Configuration section to continue setup.

Note: A desktop shortcut to Mosart Web Applications Configuration Tool is added by 
default.


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•

•

•

•

Configuration

A yellow warning icon and text CONFIGURATION REQUIRED alert if further user settings must be 
entered.

In the Timing Display panel click Open.
A Timing Display with layout editor opens. Here you can create your required timer details, 
or use the default appearance.

6.2.2 Support for main/backup Connection
Currently there is no autonomous support at switching. 

A simple workaround is creating two open Timing Display instances and manually switching 
between them.

6.2.3 Troubleshooting

Web Apps Service reports as offline
At any time you can start the Mosart Web Applications Configuration Tool and check operating 
status.

A common error is when a Windows service has failed.

Try restarting the service with the Restart button.

You can also rewrite any previously entered values with the Reconfigure button.
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1.

2.

•

•

•

Bypass the Mosart Web Applications Configuration Tool to access Web Apps
In failure situations, you can use your web browser to communicate with the Mosart Web Apps 
(instead of the Configuration Tool).

NRCS Plugin
From the Configuration Tool, copy the NRCS link (click Copy).

The URL has the form similar to: http://<your-hostname>:55142/plugin/?
nrcs=ENPS&mosid=mosart
Open you web browser and paste the URL in to see the NRCS Plugin.

Rundown Viewer
Edit the URL to: http://<your-hostname>:55142/rundown

Timing Display:
Edit the URL to: http://<your-hostname>:55142/timingdisplay/editor

Firewall Ports
Refer to the optional Configuration step Port settings (optional). 
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•
•
•

•
•

7 Mosart Rundown Viewer
The Mosart Rundown Viewer provides a convenient web browser view of details from the current 
Viz Mosart rundown.

Displays the active Viz Mosart rundown.
Summary of story timings. 
Supports a variety of devices. For example an iPad or networked phone.

This section describes:

Working with the Rundown Viewer
Setup and Administration

Note: For news-breaking details on the Mosart Rundown Viewer, please refer to the Mosart 
Web Apps Release Notes for your version of Viz Mosart, at the Vizrt Documentation Center. 



http://docs.vizrt.com/viz-mosart.html
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•
•
•

1.

7.1 Working With The Rundown Viewer
Opening the Rundown Viewer
Story Scaler
Go to On Air Story

7.1.1 Key Features
The Mosart Rundown Viewer provides a convenient, browser based display of a Viz Mosart 
rundown.

Opening the Rundown Viewer
You access the Mosart Rundown Viewer from the Mosart Web Applications Configuration Tool.

To open the Mosart Rundown Viewer
Start the Mosart Web Applications Configuration Tool.
This is either a Desktop shortcut

or accessed from the Windows Start menu by typing Mosart Web Applications.

Note: To browse a rundown in Rundown Viewer, a standard Viz Mosart setup must first be 
running with a loaded rundown. See section Setup and Administration.


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2.

3.

From the Rundown Viewer panel, click Open.

The Mosart Rundown Viewer displays in your default web browser.

Story Scaler
You can expand the viewing area for items in a story row. This is useful to see full text details on 
an item.

For a explanation of the elements in a Viz Mosart rundown, please refer to the Viz Mosart 
User Guide, under User Interface, the section Rundown Window. 



http://docs.vizrt.com/viz-mosart.html
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• Adjust the Story scaling slider to desired column width.

Go to On Air Story
A navigation button
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•
•
•

enables immediate scrolling to the current on-air story.

7.2 Setup And Administration
Setting up the Rundown Viewer

Prerequisites
Download
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•
•
•

•
•
•
•

•

•

1.

Installation
Configuration
Additional Server Settings

Troubleshooting
Web Apps Service reports as offline
Bypass the Mosart Web Applications Configuration Tool to access Web Apps
Firewall Ports

7.2.1 Setting up the Rundown Viewer

Prerequisites
Viz Mosart 5.1.0 or later

Perform all three procedures, Download, Installation and Configuration.

Download
Collect the latest software bundle from Vizrt's customer FTP at https://download.vizrt.com/
by navigating to /products/VizMosart/Latest Version/WebApplications/.

Installation
The Mosart Web Applications bundle shall be installed on the Viz Mosart server.

Run the downloaded file MosartWebApplications.Bundle-n.n.n.n.exe.

The web applications that will be installed are listed.

Note: If upgrading, make sure an existing instance of the Mosart Web Applications 
Configuration Tool is not open.



https://download.vizrt.com/
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2.

3.

4.

a.

b.

5.

1.

a.
b.

Click Install.
Any previously installed versions of the Mosart Web Applications are automatically 
upgraded. 
After successful installation, a Mosart Web Applications Configuration Tool automatically 
displays.

Port settings (optional)
Where security policies restrict ports firewall ports, these are the necessary port numbers for 
Mosart Web Applications:

Web Apps REST API
http: 55142.
https: 55143.
Remote Control Service (Used by the Timing Display and Rundown Viewer)
http: 55167.
https: 55168.

Follow the Configuration section to continue setup.

Configuration
Ensure that your Viz Mosart system is operating under normal working conditions.
As a minimum,

ManusAdmin must be running.
The Viz Mosart UI is running, displaying a rundown.

a.
b.

Note: The Installer places two applications on the local machine
Vizrt Mosart Web Applications
Vizrt Mosart Web Applications Configuration Tool



Note: A desktop shortcut to Mosart Web Applications Configuration Tool is added by 
default.


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2. From the Viz Mosart Web Applications Configuration Tool, in the Rundown Viewer panel, 
click Open.

The Rundown Viewer automatically displays in your default web browser.

Additional Server Settings

Web server hostname
At startup, the Configuration Tool attempts to autodetect the web server hostname and if 
successful, pre-populates the field.

For some setups, the Configuration Tool's web server pre-populated hostname will differ from the 
fully qualified domain name (FQDN). For example, the hostname gets automatically pre-populated 
as web-apps, yet the FQDN is web-apps.example.com.

To enable network communication with Mosart Web Apps
You can enable other machines on the network to reach Mosart Web Apps.
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1.

2.
3.

1.

2.

3.

4.

From the Configuration Tool menu bar, click the Settings (gear) icon.
The Server Configuration menu appears.

In Web server hostname, enter the FQDN.
Click Save.

Enabling HTTPS
The Web Applications suite optionally supports HTTPS authentication for the applications running 
under it, with a centralized interface to help with certificate configuration.

Step 1 - Activate HTTPS in Mosart Web Applications
Launch the Viz Mosart Web Applications Configuration Tool (a desktop shortcut is usually 
available by default).
In the top right corner, select the Settings (gear) icon.
The Server Configuration menu appears.
Select Use HTTPS.

Provide certificate, key and authentication details (consult with your IT department to obtain 
this).

Note: Depending on the application, some additional configuration may be needed in the 
connected applications (for example Viz Mosart itself) to enable HTTPS communication.



Note: This selection turns on HTTPS for the NRCS Plugin, Mosart Timing Display and 
Rundown Viewer.


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5.

1.

2.

•
•
•
•

3.

Click Save. 

Step 2 - Turn HTTPS on in Mosart Remote Dispatcher Service
Copy the file "C:\Program Files (x86)\Mosart Medialab\Mosart 
Server\ConfigurationFiles\RemoteDispatcherServiceConfig.xml" to "C:\ProgramData\Mosart 
Medialab\ConfigurationFiles".
Fill in the following fields, using the same three values from the HTTPS Configuration menu 
shown above:

SignalRUseHttps: true
SignalRCertificatePath: <Certificate File entered above>
SignalRCertificateKeyPath: <Private Key entered above>
SignalRCertificatePassword: <Password entered above>

Restart the Remote Control Service.

7.2.2 Troubleshooting

Web Apps Service reports as offline
At any time you can start the Mosart Web Applications Configuration Tool and check operating 
status.

A common error is when a Windows service has failed.
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•

•

1.

2.

•

•

•

Try restarting the service with the Restart button.

You can also rewrite any previously entered values with the Reconfigure button.

Bypass the Mosart Web Applications Configuration Tool to access Web Apps
In failure situations, you can use your web browser to communicate with the Mosart Web Apps 
(instead of the Configuration Tool).

NRCS Plugin
From the Configuration Tool, copy the NRCS link (click Copy).

The URL has the form similar to: http://<your-hostname>:55142/plugin/?
nrcs=ENPS&mosid=mosart
Open you web browser and paste the URL in to see the NRCS Plugin.

Rundown Viewer
Edit the URL to: http://<your-hostname>:55142/rundown

Timing Display:
Edit the URL to: http://<your-hostname>:55142/timingdisplay/editor

Firewall Ports
Refer to the optional Configuration step Port settings (optional). 
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•

8 Mosart Dashboard
Mosart Dashboard
This Mosart Dashboard provides essential control room information, eliminating the need of 
displaying any Mosart Server applications. 

Working with the Dashboard
Setup and Administration

This 1.0 version has minimal functionality and is provided as unsupported beta software. 
Future versions, with additional functionality, will be supported.


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8.1 Working With The Dashboard

8.1.1 Key Features
Device Status
Connection Status
Toggle Standby Mode
Server Status
Monitor a Different Mosart Server

Device Status
The Dashboard reflects current status of the devices configured on the Mosart server that are 
running on the same server as the Dashboard Service: 

Connection Status
The Dashboard reflects the connection status of the NCS connection:
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Toggle Standby Mode
You can set a device into or out of Standby with the Standby and Activate buttons:

 /  

Server Status
If a Mosart Server application ceases to function, you are warned in the Status section of the 
Dashboard:

Monitor a Different Mosart Server
You can change the Mosart Server you are monitoring. See section Monitor a Different Mosart 
Server in Setup and Administration.

8.2 Setup And Administration
The Dashboard has two parts:

the Dashboard backend
the Dashboard frontend.

Both are Windows Services and may reside on the same or on different computers.

The frontend serves the Dashboard UI, accessible from multiple computers/browsers. They are 
separate Dashboard UI instances and can connect to the same or different backends.

The backend must be installed on the computer where the Viz Mosart Server you want to monitor 
is installed.

The Dashboard UI refers to the web page that appears when requested from the Dashboard 
frontend service.

Prerequisites
Installation
Configuration

8.2.1 Prerequisites
ASP.NET Core Hosting Bundle on the machines that you install the services on
Viz Mosart 4.1.0 or later
Uninstalling of any earlier Mosart Dashboard service  versions
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•

1.

2.

3.

4.

1.

2.
a.

b.

Latest version of Google Chrome

8.2.2 Installation
From the Vizrt customer FTP (https://download.vizrt.com/), download the directory //
products/VizMosart/Latest Version/VizMosart-n.n.n/WebApplications/MosartDashboard-
n.n.n
Install the Dashboard backend (MosartDashboardService-1.0.0.0.msi) service on the same 
machine as the Mosart server installation you wish to monitor.

If the Dashboard UI will reside on a different machine to the the backend server specified in 
step (2) above, open port 55143 (in Firewall preferences).
You can skip this step, if the Dashboard UI is displayed on the same machine as the 
Dashboard backend.
Install the Dashboard frontend (MosartDashboardUIService-1.0.0.0.msi) service on any 
machine.

8.2.3 Configuration
On the machine you want to display the Dashboard, access http://HOST:8000/ in you 
browser.
HOST is the computer name/IP address of the computer where you installed the frontend 
service, at Installation step (4) above.
At initial startup, the UI will prompt you for:

The host of the backend service.
Enter the host name of the machine from Installation step (2) above.
A name for this server.
Enter a human-friendly name of your choice.

Monitor a Different Mosart Server
You can change the Mosart Server that is monitored (the Dashboard backend service, as specified 
in step (2) above, needs to be running on the target computer).

You can only monitor one Viz Mosart server per Dashboard.
However, if there are several Mosart servers that you are interested in potentially 
monitoring, (for example either a main or backup in a redundancy setup), install the 
Dashboard backend service on each additional machine.
See Monitor a Different Mosart Server below.



https://download.vizrt.com/T
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1.

2.

To select the monitored server
Click the Edit icon in the lower right corner.

Enter the new server details, as described in Configuration step (2) above.
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